
About Audio2SWF

Thank you for choosing Audio2SWF. Audio2SWF is an extremely easy program to convert your audio 
files to Macromedia Flash Movie (SWF) files.

Audio2SWF creates SWF files to be played with the Macromedia Flash Player. The latest Flash Player 
can be downloaded for free from Macromedia's web site at http://www.macromedia.com. 

http://www.macromedia.com/


System Requirements

Macintosh Requirements 

●     Power PC based Macintosh or greater 
●     Macintosh OS X or higher 
●     128 MB of RAM 
●     At least 50 MB of available hard disk space 
●     QuickTime 5.0 or higher* 

Windows Requirements 

●     Pentium processor-based PC or compatible computer 
●     Windows 98/ME/2000/XP 
●     128 MB of RAM 
●     At least 50 MB of available hard disk space 
●     QuickTime 5.0 or higher (Choose recommend Installation)* 
●     Macromedia Flash Player 5.0 or higher** 

* The latest QuickTime can be downloaded for free from Apple's QuickTime website at http://www.
quicktime.com 
** The latest Macromedia Flash Player can be downloaded for free from Macromedia's website at http://
www.macromedia.com 

http://www.quicktime.com/
http://www.quicktime.com/
http://www.macromedia.com/
http://www.macromedia.com/


Getting Started

Below is a brief description and steps to start you to convert your audio files with Audio2SWF. 

Add audio files to convert
To start using Audio2SWF you need to add audio files that you wish to convert. You can add audio files 
by browsing for them by click the "Add" button in the Audio2SWF window, selecting "Add..." from 
the "Audio" menu or dragging and dropping audio files onto the Audio2SWF window. Click here for 
more information on Adding/Removing audio files. 

Customize the conversion settings 
Use the "Settings" window to customize various properties for the conversion process. You may bring 
up the "Settings" window at any time by choosing "Settings..." from the "Audio" menu or the toolbar. 

Export/Publish the audio 
When you're ready to convert your audio files, you will need to do an export. , export or publish the slide 
show by choosing "Export..." or "Publish from the "File menu. Click here for more information on 
publishing the audio. 



Add/Remove Audio files to the Job List for converting

Adding Audio Files to the Job List 

Audio files may be added to the jobs list by: 

●     Selecting "Add..." from the "Audio" menu. 
●     Clicking on the "Add" button on the main window. 
●     Drag and drop an audio file(s) onto the main window. 

Supported audio file types include AIFF, MP3, Wave (WAV).

Removing Audio Files from the Job List 

Select the entry from the list you want to remove. Then click the "Remove" button or choose 
"Remove" from the "Audio" menu. You can also choose "Remove All" to remove all jobs from the 
list. 



Publish/Export Audio

When you're ready to deliver your audio to an audience, you must publish or export the audio to another 
format for playback. 

Export 

Exporting the audio will encode your audio to the specified output format. You can choose to export as a 
SWF, FLV or Multiple Formats at once. To export your video, select "Export" or "Export All" from 
the "File" menu or the toolbar. 

Multiple Formats 

The "Multiple Formats " option lets you specify multiple formats to export your audio. 

●     Flash Movie - a Flash Movie (SWF) file. 
●     Flash Video - a Flash Video (FLV) file. 
●     HTML - a HTML document to display the Flash Movie file. 
●     Macintosh Projector - a self executable Flash movie to run on Macintosh compatible computers 

without the need for the Flash Player to be installed on the users computer. 
●     Windows Projector - a self executable Flash movie to run on Microsoft Windows compatible 

computers without the need for the Flash Player to be installed on the users computer. 

To output your audio as multiple formats, select "Multiple Formats " from the "Format" drop down 
list in the General tab. Click the Settings... button to specify the formats you want to output. 

Multiple Formats Publish Settings 

This is where you specify which formats to output and their settings.



 
Click "OK" to save the current publish settings and close the Publish Settings dialog box. 
Click "Cancel" to close the Publish Settings dialog box without saving the current settings. 

Formats 



 
Output To: Displays the path where all published files will be saved to on disk. 
Browse: Click to specify a different location to save the published files to. 
Type: Check the filetypes you want to publish 
Filename: The filename to save the published files in the Output to location. 

HTML 



 

●     "Dimensions" 
●     "Playback" allows you to set options to control the movie's playback and features 

❍     "Paused at start" pauses the movie until a user click a button in the movie or chooses 
Play from the shortcut menu. 

❍     "Loop" repeats the movie when it reaches the last frame. 
❍     "Display Menu" displays a shortcut menu when the user right-clicks (Control + click) the 

movie. 
❍     "Device Font" will substitute anti-aliased system fonts for fonts not installed on the user's 

system. Using device fonts increases the legibility of type at small sizes and can decrease 
the movie's file size. 

●     "Quality" will set the playback quality to determine the trade-off between processing time and 
applying anti-aliasing to smooth each frame before it is rendered on the viewer's screen. 

❍     "Low" favors playback speed over appearance and does not use anti-aliasing. 
❍     "Auto Low" emphasizes speed at first but improves appearance whenever possible. 

Playback begins with anti-aliasing turned off. If the Flash Player detects that the processor 
can handle it, anti-aliasing is turned on. 

❍     "Auto High" emphasizes playback speed and appearance equally at first but sacrifices 
appearance for playback speed if necessary. Playback begins with anti-aliasing turned on. 
If the actual frame rate drops below the specified frame rate, anti-aliasing is turned off to 
improve playback speed. 



❍     "Medium" applies some anti-aliasing, but does not smooth bitmaps. It produces a better 
quality than the Low settings, but lower quality that the High settings. 

❍     "High" favors appearance over playback speed and always uses anti-aliasing. If the 
movie does not contain animation, bitmaps are smoothed. If the movie has animation, 
bitmaps are not smoothed. 

❍     "Best" provides the best display quality and does not consider playback speed. All output 
is anti-aliased and bitmaps are always smoothed. 

●     "Window Mode" allows you to set options for transparency, positioning, and layering of the 
Flash movie. This option is not compatible with all browsers. 

❍     "Window" plays a Flash Player movie in its own rectangular window on a web page, for 
the fastest animation. 

❍     "Opaque Windowless" moves elements behind Flash movies to prevent them from 
showing through 

❍     "Transparent Windowless" shows the background of the HTML page on which the 
movie is embedded through all transparent areas of the movie, but may slow animation. 

●     "HTML Alignment" allows you to position the Flash movie window within the browser 
window. 

❍     "Default" centers the movie in the browser window and crops edges if the browser 
window is smaller than the movie. 

❍     "Left, Right, Top, Bottom" aligns the movie along the corresponding edge of the browser 
window and crops the remaining three sides as needed. 

●     "Scale" allows you to place the movie within specified boundaries. 
❍     "Default (Show All)" displays the entire movie in the specified area without disortion 

while maintaining the original aspect ratio of the movie. 
❍     "No Border" scales the movie to fill the specified area and keeps the movie's original 

aspect ratio without distortion and crops if needed. 
❍     "Exact Fit" displays the entire movie in the specified area without preserving the original 

aspect ratio, which may cause distortion. 
●     "Flash Alignment" allows you to set how the movie is placed within the movie window and 

how it is cropped, if necessary. 
❍     "Left, Center, Right" are used for horizontal alignment. 
❍     "Top, Center, Bottom" are used for vertical alignment. 

Projectors 



 

Fullscreen: If checked, the Projector will run in full screen mode when launched. While in full screen 
mode during playback, the user can hit the Escape key to exit the full screen mode. 
Allow Scale: If checked, the movie will scale to the size of the window 
Show Menu: If checked, the contextual menu will be enabled.

Expire On: If checked, the projector will expire on the specified date and display your custom Message. 
Message: The message to display when the projector expires. 



Save/Load Projects

Saving Audio2SWF Projects 

You can save the settings for your current session to a Audio2SWF Project file (.a2s) by choosing "Save 
Project" or "Save Project As..." from the "File" menu or toolbar. To overwrite the current project file, 
choose "Save Project". To save the file in a different location or with a different name, choose "Save 
Project As...". 

Please note that the project file does not save any sounds used in the project. If you move or delete any 
of the files used in the project, Audio2SWF will not be able export the files properly. 

Loading Audio2SWF Projects 

You can load and previously saved Audio2SWF Project file (.a2s) by choosing "Open Project" from 
the "File" menu or toolbar. 



Audio2SWF

The Audio2SWF window is the main window and is where you add and remove the source files you 
wish to encode. 

 

Add...: Choose a source audio file to encode. After choosing a source file, it will be added to the list of 
jobs to encode. You can also add audio files by choose Add... from the Audio menu or by dragging and 
dropping audio files onto the Audio2SWF window. 
Remove: Remove the current selected job from the list.
Remove All: Remove all jobs from the list.
Export: Encodes the current selected job from the list.
Export All: Encode all jobs from the list. 



Source

The Source window will display your source audio where you can view and edit the audio for encoding. 

 

Setting In/Out Points

If in the Edit tab the "Match source duration" is not checked, you have the ability to choose a section of 
the audio to encode. Here you will see two triangular markers below the timeline which you can drag to 
set the Start and End times of the section of the audio you wish to encode. 



Settings

The Settings dialog allows you to customize the output settings for the current selected audio. 

 



General

The General tab allows you to set the basic input and output settings. 

 

Input

The "Input" area allows you to specify the input source audio you wish to convert. 



 

Path: The full path of the source audio file to convert will be displayed here.
Browse...: Click to choose a different source audio file. 

Output

The "Output" options allow you to specify the general settings for the output. 

 

Path: The full path of where the converted file will be saved to will be displayed here.
Browse...: Click to choose a different location to save the converted file to.

Format: Choose which format you wish to convert the source video file to. 

●     SWF: The Macromedia Flash file format to be played back in the Macromedia Flash Player. 
●     FLV: The Macromedia FLV file format lets you import a static video stream into the 

Macromedia Flash authoring tool. 
●     Multiple Formats...: Output multiple file formats at the same time. Choose from SWF, FLV, 

HTML, and Projector files. Click the Settings... button to specify the formats you wish to output. 

Preset: You can choose a pre-defined preset from the list, which will automatically set the settings for 
you. If you want to use your own settings, choose None.



Frame Rate: The frame rate (frames per second) of the converted SWF/FLV file.
Width: The width in pixels of the SWF file.
Height: The height in pixels of the SWF file.
Bg Color: The background color of the swf file. 

Protect: If checked, Macromedia's Flash Authoring Tool will not be able to import the exported .swf 
file. 
Compress: If checked, the exported .swf file will be compressed. To playback compressed .swf files, 
the viewer will need version 6 or higher of the Flash Player.
Disable Printing: If checked, the Print option from the Flash Player will be disabled. 



Audio

The Audio tab allows you to see the properties of the audio source and set the output quality settings. 

 

Input Properties

The "Input Properties " displays various properties of the input audio source.



 

Format: The format of the audio source.
Sample Rate: The sample rate of the audio source.
Sample Size: The sample size of the audio source.
Duration: The duration of the audio source.
Channels: The number of channels in the audio source.

Output Settings

The "Output Settings " allows you to choose various settings to control the quality of the encoded 
audio. 

 

Codec: The codec to use when encoding the audio. 

●     MP3

Sample Rate: The sample rate to use when encoding the audio. Higher sample rates will result in higher 
audio quality, but larger file sizes.
Bit Rate: The bit rate to use when encoding the audio. Higher bit rates will result in higher audio 
quality, but larger file sizes.
Channels: The number of channels to use when encoding the audio.



Edit

The "Edit" tab allows you to edit the audio for encoding. 

 

In/Out

The "In/Out" options allows you to specify a section of the audio to encode. 



 

Match source duration : If checked the Start and End times will automatically be set to encode the 
entire duration of the source audio.
Start (Hour/Minute/Second/Millisecond): The starting time of the audio source to encode.
End (Hour/Minute/Second/Millisecond): The ending time of the audio source to encode.
Duration: The duration of the audio source to encode.

Fade In/Out

The "Fade In/Out" options allows you to fade in/out the encoded audio. 

 

Fade In: Check if you want to fade in the audio and enter in the number of seconds you want the Fade 
In to take to complete.
Fade Out: Check if you want to fade out the audio and enter in the number of seconds you want the 
Fade Out to take to complete.



SWF

The SWF tab allows you to customize the how the SWF file will playback. 

 

Movie Start Action

The "Movie Start Action" options allows you to specify how the audio will begin to playback. 



 

Play Automatically: Start playing the SWF as soon as it is loaded into the Macromedia Flash Player. 
Play After Pause: Start playing the SWF after the desired number of seconds has elapsed. 
Stop on First Frame: Load the SWF into the Macromedia Flash Player and then stop until there is user 
interaction to contiue playing the SWF. 
Click to begin: Load the SWF into the Macromedia Flash Player and then stop until the user clicks on 
the SWF to continue playback.

Preload: Allows you to add a preloader to the audio. If this option is chosen, a progress bar will be 
displayed showing the percentage of the audio that has been downloaded/loaded into the Macromedia 
Flash Player. When the desired percentage of the SWF file has been loaded, playback of the audio will 
begin. This option is helpful to allow smoother playback on slower internet connections. Click the 
Settings... button to customize the preloader. 

Loop

The "Loop" options allows you to choose the number of consecutive times the audio will play. 

 

Play Once: Play the entire SWF and stop after the last frame is reached. 
Loop: Repeat the SWF the desired number of times and then stop. 
Play Forever: Continually play the entire SWF. 



Mouse Click Action

The "Mouse Click Action " option allows you to specify an action to take when the user mouse clicks 
the Macromedia Flash Player while the audio is playing. 

 

Action: The action to take when the user mouse clicks on the SWF. 

●      None: No action to take.
●      Get URL: Loads a standard URL (eg. http://www.verticalmoon.com)
●      Load SWF: Loads an external SWF file (eg. another.swf)

Target: If the Action is Get URL or Load SWF, you can specify the target to load the URL/SWF to. 

●      Custom: Specify your own target
●      Pop-Up Window: Loads the URL/Path to a pop-up window. When choosing this option a 

Settings... button will appear to customize the Pop-Up Window Settings. For the pop up window 
to work properly you will either need to export both the .swf and .html files from the "Publish 
Settings..." or add the following javascript code to your html file that displays the .swf file 
between the <HEAD> and </HEAD> tags.
<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {newWin=window.open(theURL, 
winName, winFeatures); }
</SCRIPT> 

●      _blank: Creates a new browser window and loads the URL/Path into it.
●      _parent: Removes the current frameset and loads the URL/Path in its place. Use this option if 

you have multiple nested framesets, and you want your URL to replace only the frameset in 
which your movie resides.

●      _self: Loads the URL/Path into the same frame or window as the current movie. 
●      _top: Loads the URL/Path into the current browser and removes all framesets in the process. 

Use this option if your movie is in a frame, but you want your linked URL to load normally into 
the browser, outside the confiness of any frames.

Movie End Action



The "Movie End Action" option allows you to specify an action to take when the SWF ends. 

 

Action: The action to take when the SWF ends. 

●      None: No action to take.
●      Get URL: Loads a standard URL (eg. http://www.verticalmoon.com)
●      Load SWF: Loads an external SWF file (eg. another.swf)
●      Unload SWF : Cause the Flash Player to unload the SWF from the player when it ends. This 

option causes the SWF file to be removed from RAM. 

Target: If the Action is Get URL or Load SWF, you can specify the target to load the URL/SWF to. 

●      Custom: Specify your own target
●      Pop-Up Window: Loads the URL/Path to a pop-up window. When choosing this option a 

Settings... button will appear to customize the Pop-Up Window Settings. For the pop up window 
to work properly you will either need to export both the .swf and .html files from the "Publish 
Settings..." or add the following javascript code to your html file that displays the .swf file 
between the <HEAD> and </HEAD> tags.
<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {newWin=window.open(theURL, 
winName, winFeatures); }
</SCRIPT> 

●      _blank: Creates a new browser window and loads the URL/Path into it.
●      _parent: Removes the current frameset and loads the URL/Path in its place. Use this option if 

you have multiple nested framesets, and you want your URL to replace only the frameset in 
which your movie resides.

●      _self: Loads the URL/Path into the same frame or window as the current movie. 
●      _top: Loads the URL/Path into the current browser and removes all framesets in the process. 

Use this option if your movie is in a frame, but you want your linked URL to load normally into 
the browser, outside the confiness of any frames.



Preloader Settings

The Preloader Settings dialog allows you change the settings for a preloader.

 

Preloader 

Preload %: The percentage of the file you wish to preload before attempting to playback the swf file.
Message: Any message you wish to display while the file is being preloaded.
Font: The font to use for the Preload % and Message.
Font Color: The color to use for the Preload % and Message text.

Import Preloader from SWF, Lock & Load

Import...: Allows you to choose a SWF, Lock & Load project file (.lkl) to import.
Edit...: Launches SWF, Lock & Load to allow you to further edit the SWF, Lock & Load project file.
Remove: Removes the current SWF, Lock & Load project file chosen for import.

http://www.verticalmoon.com/products/swflockload


Pop-Up Settings

The Pop-Up Settings dialog allows you to customize the pop-up window

 

W: The width of the pop up window.
H: The height of the pop up window.
X: The horizontal position to display the pop up window.
Y: The vertical position to display the pop up window.

Resizable: Specifies whether or not the user may resize the popup window.
Scrollbar: Specifies whether horizontal and vertical scrollbars should be added to the pop up winodw. 
Most browsers will display the scrollbars only when needed to view content beyond the window area.
Toolbar: Specifies whether the toolbar should be shown. The toolbar contains the browser's navigation 
buttons such as Back, Forward, Reload, and Home.
Directory Bar: Specifies whether the directory bar should be shown. 
Status Bar: Specifies whether the status bar should be shown. The status bar area contains the security 
inidicator and status bar messages.
Location Bar: Specifies whether the location bar should be shown. The location bar is where the URL 
of the current page is shown.
Menu Bar: Specifies whether the menu bar should be shown. The menu bar contains the browser's 
menus such as File, Edit, and View.

In order for the pop up window to function properly, you must add the following javascript snippet to 
your HTML code. You can copy and paste the following anywhere between the <HEAD> and </
HEAD> tags which should be located towards the top of the HTML code.



<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {
newWin=window.open(theURL, winName, winFeatures);
}
</SCRIPT>



Players

The "Players" tab allows you to add a Player to the encoded audio to add playback and audio controls. 

 

Players List 

This is a list of the available Player templates to choose from. Once selected, you can see a Preview of 



the player to the right of the list. You can also add your own players by following our Players 
Specification. 

 

Customize

For certain Player templates, you have the ability to customize some of the features of the Player. 

 

Parameter List : If available, you will see a list of all of the parameters you can customize for the 
current selected Player template. Once you select a parameter in the list, you will have the ability to 
change the value to the right. 

Set Default Values : This will revert all of the values for the current Player back to their default values. 



Players Specification

You can create your own custom player templates to be used in Audio2SWF by following the 
specifications found on this page. You can create your players with the Macromedia Flash authoring 
tool. Once created, you can add the players to the Players folder where Audio2SWF is installed, and the 
next time you launch Audio2SWF, you should see the new players added to the list.

The following specification will describe the overall layout and what is required or optional when 
creating your players. 

●     Player Hierarchy
❍     Parameters/Variables (required actionscript)
❍     videoPlayer (required)

■     video (required)
■     frame

■     frame_n (where n is 1...number of elements in the frame)
■     vidBtns

■     rwBegBtn
■     rwBtn
■     playPauseBtn
■     playBtn
■     pauseBtn
■     stopBtn
■     ffBtn
■     ffEndBtn

■     sndBtns
■     muteBtn
■     volSlider

■     volBtn
■     volBar

■     vidBar
■     progressBtn
■     progressBar
■     loadBar
■     bgBar

■     clock
■     time_cur
■     time_rem



Parameters/Variables

The first frame of the maintimeline is where you can specify how the elements in the player should 
position and scale relative to the size of the video within the Player.

Required:
format = "video2swf";
version = "1.0";
name = "The name of your player to be displayed in Audio2SWF "; 

Optional:
min_player_width = (the minimum width in pixels the player can be);
min_player_height = (the minimum height in pixels the player can be);

ITEM_hanchor = "none/left/center/right"; (where ITEM is the name of the element to set the anchor for; 
eg. vidBtns_hanchor="left";)
ITEM_vanchor = "none/top/center/bottom"; (where ITEM is the name of the element to set the vanchor 
for; eg. vidBtns_vanchor="bottom";)

ITEM_hstretch = "true/false/fixed"; (where item is the name of the element to set the stretch for; eg. 
frame_1_hstretch="true";)
ITEM_vstretch = "true/false/fixed"; (where item is the name of the element to set the stretch for; eg. 
frame_1_vstretch="false";)

vidbar_width: If using a vidBar in the Player, you will need to set this to the original width of the bar.
vidbar_scroll: If using a vidBar with a slider button, you will need to set this to the original amount it 
can scroll within the vidBar. 

volSlider_scroll: If using a volSlider, you will need to set this to the original amount it can scroll within 
the volSlider. 

videoPlayer 

The first frame of the maintimeline must have an instance of the movie clip that holds the entire player 
and it's elements. The instance must be named "videoPlayer". The videoPlayer should be placed at (0,0) 
and the Document dimensions should match the size of the videoPlayer. 

Required:
video



Optional:
frame
vidBtns
sndBtns
vidBar
clock

video 

The video instance will define where the actual video will be placed in the player. The instance must be 
named "video" and should contain a rectangle shape defining the area for the video. The video and 
elements around the video will automatically be adjuted based on the actual dimensions of the Flash 
video. 

frame 

The frame can be used to create the background for the player. For each element in the frame, there will 
be an instance named "frame_n" where "n" is a number from 1...number of frame elements. 

vidBtns 

The vidBtns can contain the buttons to control the playback of the audio, such as rewinding, fast 
forwarding, pausing and playing. 

Optional: The following must be Movie clip instances with the following names which contain the 
actual Button. For toggle buttons, the first button state must be in the first frame of the containing movie 
clip, and the second state must be in the second frame. 

rwBegBtn: Jump to the beginning of the audio 
rwBtn: Rewinds the audio 
playPauseBtn: Toggle button to play and pause the audio
playBtn: Plays the audio 
pauseBtn: Pauses the audio 
stopBtn: Stops the audio 
ffBtn: Fast forwards the audio 
ffEndBtn: Jump to the end of the audio 



sndBtns 

The sndBtns can contain the controls to control the audio such as muting and changing the volume. 

Optional: The following must be Movie clip instances with the following names which contain the 
actual Button. For toggle buttons, the first button state must be in the first frame of the containing movie 
clip, and the second state must be in the second frame. 

muteBtn: Toggle button to mute and unmute the audio
volSlider: Slider bar to set the volume. This must have an instance named volBar which is the 
background bar, and a volBtn which is the slider button. The first frame variables should have the 
following volSlider_scroll set to the number of pixels the volBtn can scroll.

vidBar

The vidBar can be used to add a scrubber and to show the current position in the video. 

Optional: The following must be Movie clip instances with the following names which contain the 
actual Button. For toggle buttons, the first button state must be in the first frame of the containing movie 
clip, and the second state must be in the second frame. 

The first frame variables should have a variable vidbar_width set to the original width of the vidBar.
The first frame variables should have a variable vidbar_scroll set to the number of pixels the 
progressBtn can scroll.

progressBtn: Button to show the current position in the video. Can also be used to scrub through the 
video by dragging it along the video bar. 
progressBar: A bar showing the current position in the video
loadBar: A bar showing the current amount of the video loaded/buffered 
bgBar: The background bar 

clock 

The clock can display relevant times for the audio, such as the current time and the remaining time. 

Optional:
time_cur: Displays the current time of the audio. This must be a dynamic text field with the variable 
name set to "time_cur"
time_rem: Displays the remaining time of the audio. This must be a dynamic text field with the variable 
name set to "time_rem" 



Custom Variables 

You can allow certain elements to be customizable from within Audio2SWF by adding variables. The 
following is an example for allowing the user to choose the color for the video buttons. 

v2sVar1_name = "videoPlayer.vidBtnsColor";
v2sVar1_type = "color";
v2sVar1_value = "0xffffff";
v2sVar1_label = "Video buttons color";
v2sVar1_notes = "Color of the video buttons playback buttons";

Each custom variables entry must begin with v2sVarN_ (where N is the variable number).
_name: Then name of the actual variable used in Flash
_type: Type of variable. Can be the following: 

●     alphanum: alpha numeric string (eg. "my value 123")
●     alpha: alpha (eg. "my value")
●     int: integer values (eg. 1, 2, 3)
●     float: decimal values (eg. 3.14, 5.29)
●     bool: true or false
●     color: RGB color in hex format 0xRRGGBB

_value: The default value for the variable
_label: The name to be displayed in the list of variables in Audio2SWF
_notes: A description of the variable which will be displayed in Audio2SWF 



Frequently Asked Questions

What is a SWF file?
The Macromedia Flash file format (SWF) (pronounced "swiff") delivers vector graphics and animation 
over the Internet to the Macromedia Flash Player.

What is a FLV file?
The Macromedia FLV file format lets you import a static video stream with encoded audio.

What version of the Flash Player are the SWF files exported from Audio2SWF compatible with?
The SWF files produced are compatible with the Flash Player vesrion 6 and up. If you are publishing 
Projector files, the Flash Player is not needed, and thus the minimum Flash version is irrelevant.

Flash will not import my audio SWF files. Why? 
Flash will not import SWFs completely that contain audio, video, and actionscript. Instead you should 
use the loadMovie actionscript command. 

There isn't any audio when I encode my audio. What should I do? 
If running Windows, install or re-install the latest QuickTime with the "Recommended" Installation 
option checked.

What is the maximum audio duration that I can encode?
The Flash player imposes a 16,000 maximum frame limit on SWF files. Anything beyond this will not 
be displayed. So the actual maximum duration will depend on the frame rate used for the SWF file 
(10fps = ~26 minutes).
Flash FLV files however do not have this 16,000 frame limit. 

How can I get around the 16,000 frame limit?
If you are exporting as SWF, you will need to split up the audio and chain the SWFs together by adding 
a End Movie Action which will load in the next SWF file.
If you are exporting as a FLV file , there isn't any 16,000 frame limit.

Can I add my own Players to Audio2SWF?
Yes, it is possible to create your own custom Players and add them for use in Audio2SWF. You will 
need to use Macromedia's Flash authoring tool and follow our specification for creating Players for 
Audio2SWF. 



Contact Us

E-mail: 
support@verticalmoon.com 

Web: 
http://www.verticalmoon.com/support 

mailto:support@verticalmoon.com
http://www.verticalmoon.com/support
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